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1 Main Index

Swirlique Help Index

Getting Started

Swirligue Remote

Channel Guide

Commands
File menu
Edit menu
Image menu
Color menu
View menu
Window menu
A/V menu
Demo menu

Help menu
1.1 Title Bar

Title Bar

Thetitle bar is located along the top of awindow. It contains the name of the application and
drawing.

To move the window, drag thetitle bar. Note: Y ou can aso move dialog boxes by dragging
their title bars.

A title bar may contain the following elements:
« Application Control-menu button

= Drawing Control-menu button

= Maximize button

= Minimize button

= Name of the application

= Name of the drawing

» Restore button
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1.2

1.3

1.4

1.5

Scroll bars

Scroll bars

Displayed at the right and bottom edges of the drawing window. The scroll boxes inside the
scroll bars indicate your vertical and horizontal location in the drawing. Y ou can use the
mouse to scroll to other parts of the drawing.

Size
Sizecommand (System menu)

Use this command to display afour-headed arrow so you can size the active window with the
arrow keys.

&

After the pointer changes to the four-headed arrow:

1. Pressone of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer
to the border you want to move.

2. PressaDIRECTION key to move the border.

3. PressENTER when the window is the size you want.

Note: Thiscommand is unavailable if you maximize the window.

Shortcut
Mouse:  Drag the size bars at the corners or edges of the window.

Move

M ove command (Control menu)

Use this command to display afour-headed arrow so you can move the active window or
dialog box with the arrow keys.

&

Note: Thiscommand is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7

Minimize Command

Minimize command (application Control menu)

Use this command to reduce the Swirlique window to an icon.
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Shortcut

Mouse: Click the minimize icon IEI on the title bar.
Keys. ALT+F9

1.6 Maximize Command

M aximize command (System menu)
Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse:  Click the maximizeicon EI on thetitle bar; or double-click the title bar.
Keys. CTRL+F10 enlarges a drawing window.

1.7 Next Window

Next Window command (drawing Control menu)

Use this command to switch to the next open drawing window. Swirlique determines which
window is next according to the order in which you opened the windows.

Shortcut
Keys. CTRL+F6

1.8 Previous Window

PreviousWindow command (drawing Control menu)

Use this command to switch to the previous open drawing window. Swirlique determines
which window is previous according to the order in which you opened the windows.

Shortcut
Keys. SHIFT+CTRL+F6

1.9 Close

Close command (Control menus)
Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.
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Shortcuts
Keys: CTRL+F4 closes a drawing window
ALT+F4 closes the application

1.10 Restore

Restorecommand (Control menu)

Use this command to return the active window to its size and position before you chose the
Maximize or Minimize command.

1.11 Switch to

Switch to command (application Control menu)

Use this command to display alist of al open applications. Usethis"Task List" to switch to
or close an application on the list.

Shortcut
Keys. CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with adialog box with the
following options:
Task List
Select the application you want to switch to or close.
Switch To
Makes the selected application active.
End Task
Closes the selected application.
Cancel
Closes the Task List box.
Cascade
Arranges open applications so they overlap and you can see each title bar. Thisoption
does not affect applications reduced to icons.
Tile
Arranges open applications into windows that do not overlap. This option does not affect
applications reduced to icons.
Arrangelcons
Arranges the icons of all minimized applications across the bottom of the screen.

© 2004-2008 ... Mystic Fractal
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2.1

2.2

2.3

2.4

2.5

2.6

Swirligue Remote

Swirligue Remote

The remote provides access to many of the most-used commands in Swirlique. Info about
each button can be obtained by using the *? located near the close box in the top right-hand
corner.

New

New button

Use this button to create a new drawing window in Swirlique.
Undo

Undobutton

Use this command to undo the last action. Color-cycling is disabled after using Undo.
Size
Size button

This allows you to set the drawing area for a picture, independent of the Windows screen size.
It also showswhich sizeis currently in use. The aspect for the drawing is based on the ratio
of X (horizontal width) to Y (vertical height.) The custom setting allows for any size that
system memory will permit. The minimum size for an image is 40X30. Note: the image
aspect isfixed at 1/1, and images are scaled to fit the drawing window horizontally. Some
images require that the drawing window be resized vertically to contain al of the curve.

Color

Color button
Use the palette editor to modify the palette(s) in use.
Batch

Batch button

Here you set parameters for randomizing, batching and saving random-generated imagesto
disk.

FVR

FVR button

© 2004-2008 ... Mystic Fractal



11 Swirlique Application Help
The window opened contains all the major variables that Swirlique now scales between key
frames of an avi stream.
2.7  Draw button
Draw button
Use this button to draw or redraw the image for the current fractal variables. Clicking inside
the draw window with the left-mouse button stops all plotting. Use the Cont button to restart
plotting from the current column. When the Isystem option is selected, a custom dialog is
opened to enter |system draw options.
2.8  Abort button
Abort button
Use this command to stop drawing. Clicking inside awindow's drawing area or close box (or
the program close box) will also stop the drawing. Note: once a plot has started Swirlique
continues to draw the image for that window regardless of which drawing window has the
input focus, until done or aborted. Y ou can open and close other drawing windows without
affecting the current drawing, but only one drawing is active at any time.
2.9 View
View button
Displays the entire plot, expanding or shrinking the image to fit in a maximized window
without title bar, scroll bars or menu bar. At al other times, part of the picture is hidden by
the inclusion of the title bar, toolbar, scroll bars and menu bar. To exit full-screen mode,
press any key or click the left-mouse button.
2.10 Help
Help button
Use this button to open the help index for Swirlique.
2.11 Channel Guide

Channel Guide
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2.12

2.13

2.14

2.15

2.16

2.17

The ten channels accessed via the Swirlique remote:

G1 -- Generate random Grandma's parabolic commutator groups

G2 -- Generate random Grandma's four-alarm two-generator groups

G3 -- Generate random Grandma's parabolic commutator (variation of G1)
G4 -- Generate random Grandma's parabolic commutator (variation of G1)
J1 -- Generate random Jorgensen parabolic groups #1

J2 -- Generate random Jorgensen parabolic groups #2

J3 -- Generate random Jorgensen parabolic groups (variation of J2)

M -- Generate random Jorgensen parabolic groups (variation of J1)

Maskit -- Generate random Maskit parabolic groups

Riley -- Generate random Riley parabolic groups

Gl
G1 Channel
Random Grandma's parabolic recipe
G2
G2 Channel
Random Grandma's four-alarm recipe
G3
G3 Channel
Random Grandma's parabolic recipe (variation)
G4
G4 Channel
Random Grandma's parabolic recipe (variation)
J1
J1 Channel
Random Jorgensen's recipe #1
J2
J2 Channel

Random Jorgensen's recipe #2

12
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2.18

2.19

2.20

2.21

2.22

2.23

2.24

J3

J3 Channel
Random Jorgensen's recipe #3
J4

J4 Channel
Random Jorgensen's recipe #4
Maskit

Maskit Channel
Random Maskit's recipe
Riley

Riley Channel
Random Riley's recipe
Save

Savebutton

Use this button to save and name the active drawing. Swirlique displays the Save Asdialog
box so you can name your drawing.

To save adrawing with its existing name and directory, use the File/Save command.
Load

L oad button

Use this button to open an existing data/image file in anew window. Use the Window menu
to switch among the multiple open images.

Bmp
BM P button

Use this button to select the BMP format when loading and saving fractals. Thisisthe default
Windows bitmap format, readable by most Windows programs that use image files. Thisis
also the fastest method of loading and saving fractals, but requires more disk space, since no
compression is used. Windows keeps track of the last six BMP files saved or loaded
(displayed in the Files menu.)
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2.25 Png
PNG radio button

Use this button to select the PNG format when loading and saving fractals. Thisformat uses
medium compression without loss of image quality.

2.26 Jpg

JPG radio button

Use this button to select the JPEG format when loading and saving fractals. Thisformat uses
moderate compression but with some loss of image quality. Preferable for posting to the net,
since most browsers can display jpeg files.

2.27 Il

[[]l] button
Through a series of windows, this allows you to name and open an avi animation stream and
choose a compression method. After choosing the frame rate (1-60) and using the file
requester to name the file, you are given a choice of compression methods. Y ou can aso
choose no compression for optimum view quality. (All compression methods degrade the
original images, some more than others.) Thefirst key frame in the stream is then drawn and
written to the file.

Note: after the stream is opened, the size of the fractal that can be drawn is fixed at the size of
the frame. No changes can be made to the size until the stream is closed.

2.28 >

> putton
With this option, frames are written to a stream based on the difference between the current
key frame and the previous key frame. Thefirst key frame is written when you open a
stream. The next key frame is created each time you use this option. In between you can
zoom or change Fvr variables as much as necessary. The stream is only written to when this
optionisused. Thelast key frame is automatically saved after the 'tween' seriesis written.
The number of frames may range from 1-1500 frames between keys. With aframe number of
1 only the key frames are written. This allows animation to be created that incorporate all
scalable variables in Swirlique.

Use the Cancel button to exit this dialog without initializing a new series of frames.
Check the Log Scaling box if you want the frames to be written with logarithmic space

between frames, else linear space is used. Useful when zooming, where frames would
otherwise be packed together at the end of the frame series.
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2.29

2.30

[l

[ ] button

Closes any open avi stream file. Y ou need to do this before viewing the file or creating a new
avi file. The stream is also closed when you exit Swirlique.

Vv

V button

Opens an avi file for viewing. You can preview any multimediafile by clicking onitsfile
name. A multimedia box will appear to the right of the filelist. Click on okay to open the

main view window.

There are buttons to Play afile forwards or Backwards, or forward automatically with Auto
rewind/repeat. Click on Slow to slow down avideo. Each click on Slow halves the viewing
speed. A click on Stop freezes viewing and restores the view speed to normal playback.

Use the Open button to view a different avi file. Use the Save button to save thefilein a
different compression format. Y ou must use a different name to save the file than the name
that was used to open it. Click on the left-mouse button or any key to abort a save operation.

Note: the view avi requester can be used to preview any multimediafile, including midi files.

File menu

Filemenu commands

The File menu offers the following commands:

New

Open

Close

Save

Save As

Load Parameters
Load Par File
Load Palettes [PL]

Open [JPEG]

Open [PNG]
Load Text [SWT]

Save Parameters
Save Par File
Save Palettes [PL]
Save As[JPEG]
Save As[PNG]
Save Text [SWT]

Export options

Creates a new drawing.

Opens an existing drawing.

Closes an opened drawing.

Saves an opened drawing using the same file name.

Saves an opened drawing to a specified file name.

L oad parameters from an existing drawing.

Load a parameters definition file.

Load palettesfile.

Load jpeg.

Load png.

Load text (platform-independent) datafile.

Save parameters for an opened drawing to a specified file name.

Save a parameters definition file.

Save palettesto file.

Savein jpeg format.

Savein png format.

Save data in text (platform-independent) format.
Savein 3-D format, OBJor POV.
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File menu 16

Exit Exits Swirlique.

3.1 File New command

New command (File menu)

Use this command to create a new drawing window in Swirlique. The image and data for the
opening picture are used to create the new window.

Y ou can open an existing data/image file with the Open command.

Shortcuts
Keys. CTRL+N

3.2 File Open command

Open command (Filemenu)

Use this command to open an existing data/image file in anew window. Use the Window
menu to switch among the multiple open images. See Window 1, 2, ... command.

Y ou can create new images with the New command.

Shortcuts

Toolbar:
Keys. CTRL+O

3.2.1 File Open dialog box
File Open dialog box

The following options allow you to specify which file to open:
FileName
Type or select the filename you want to open. This box lists files with the extension you
select inthe List Files of Type box.
List Filesof Type
Select the type of file you want to open:
<< List your application'sfile types here. >>
Drives
Select the drive in which DFS stores the file that you want to open.
Directories
Select the directory in which Swirlique stores the file that you want to open.
Network...
Choose this button to connect to a network location, assigning it a new drive |etter.
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3.3

3.4

3.5

3.5.1

File Close command

Close command (Filemenu)

Use this command to close the window containing the active image. If you close a window
without saving, you lose all changes made since the last time you saved it.

Y ou can aso close adrawing by using the Close icon on the drawing window, as shown
below:

File Save command

Save command (File menu)

Use this command to save the active drawing to its current name and directory. When you
save adrawing for the first time, Swirlique displaysthe Save As dialog box so you can
name your drawing. If you want to change the name and directory of an existing drawing
before you save it, choose the Save As command.

Shortcuts

Toolbar:

Keys. CTRL+S

File Save As command

Save Ascommand (File menu)

Use this command to save and name the active drawing. Swirlique displays the
Save As dialog box so you can name your drawing.

To save adrawing with its existing name and directory, use the Save command.

File Save as dialog box

File Save Asdialog box

The following options allow you to specify the name and location of the file you're about to
save
File Name
Type anew filename to save a drawing with a different name. A filename can contain up
to eight characters and an extension of up to three characters. Swirlique adds the
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3.6

3.7

3.8

3.9

extension you specify in the Save File As Type box.
Drives
Select the drive in which you want to store the drawing.
Directories
Select the directory in which you want to store the drawing.
Network...
Choose this button to connect to a network location, assigning it a new drive |etter.

File Load Parameters command

L oad Parameterscommand (File menu)

Use this command to load adatafile [.dfs]. The datafile contains all variables to recreate an
image created previously with Swirlique.

Load Par File

Load Par File

Opens awindow that allows the user to select and convert Swirlique parameter files to
Swirligue format. A list of par titlesis displayed for each .par file loaded. The user then
selects atitle and clicks on Convert to trandlate it to the current image data.

Select Load Palette to load a par palette only without changing the current function data.

Related Topics:
Edit Palette describes the Swirlique palette editor.

File Load Palettes command

L oad Palettescommand (File menu)

Use this command to load a palette file [.pl]. The palette file contains 21 palettes created
previously with Swirlique (or another version of the program.)

File Open [JPG] command
Open [JPEG] command (File menu)

Use this command to load parameters and a bitmap file that were saved in jpeg format. There
isan option in the file-type box to load only the bitmap too. This replaces the Open
command for those who need a smaller sized bitmap file. Note: the last files list doesn't keep
track of images loaded in JPEG format.
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3.10

3.11

3.12

3.13

File Open [PNG] command

Open [PNG] command (File menu)

Use this command to load parameters and a bitmap file that was saved in png format. There
isan option in the file-type box to load only the bitmap too. This replaces the Open
command for those who need a smaller sized bitmap file. Note: the last files list doesn't keep
track of images loaded in PNG format.

File Load Text [SWT) command
Load Text [SWT) command

Load text (platform-independent) datafile. Useful for transferring data files between
Swirlique and iSwirlique.

File Save Parameters command

Save Parameter scommand (File menu)

Use this command to save all data elements for the current image in a data file [.dfg].

Save Par File

Save Par File

This option allows you to save Swirlique parameters and color info in atext format similar to
Fractint's .par format. Y ou can build par libraries of your favorite fractals to share with other
users of Swirlique. The par definitions can be easily posted on the net and reloaded in
Swirligue through the Load Par command.

Specify the par file name with the Filename button. This can be a generic file name, such as
"complex.par”, for alibrary of par titles, or a specific file name based on the fractal's .dfs.
The later file name isthe default. Use the Par Title box to specify the fractal's name or
description. Add acomment to the par definition with the Comment box. When you click on
Okay, if afile with the Par Filename doesn't exist, it will be created and the par definition
added to it. If thefile exists, Swirlique will scan the file for a par title the same as the one
being added. If it doesn't exist, the par definition will be added to the end of the par file. If it
exists, you have the option to replace the old definition with the new one. If you choose not
to replace the old definition, the existing par file remains unchanged and no further action is
taken.
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3.14

3.15

3.16

3.17

3.18

3.18.1

File Save Palettes command

Save Palettes command (File menu)

Use this command to save al palettes for the current session in a palette file [.pl].

File Save As [JPG] command

Save As[JPEG] command (File menu)

Use this command to save the parameters and active bitmap in jpeg format. Thereisan
option in the file-type box to save only the bitmap too. This replaces the Save and Save A<
command for those who need a smaller sized bitmap file. Note: the last files list doesn't keep
track of images saved in JPEG format.

File Save As [PNG] command
Save As[PNG] command (File menu)

Use this command to save the parameters and active bitmap in png format. There is an option
in the file-type box to save only the bitmap too. This replaces the Save and Save A<
command for those who need a smaller sized bitmap file. Note: the last files list doesn't keep
track of images saved in PNG format.

File Save Text [SWT) command
Save Text [SWT) command

Save datain text (platform-independent) format. Useful for transferring data files between
Swirlique and iSwirlique. Some differences between rendering styles may be observed, but
image shapes should be maintained.

Export options
Save Kleinian set as 3-D object(s) in POV or OBJ format.
Save [OBJ] command

Save Figure[OBJ] command (File menu)

When the active figureisacircle or cyclinder plot, then this command is enabled and may be
selected. After naming the object file through afile requester, the current figure is redrawn
and the cylinder or circle plot will be written to a Wavefront obj file as triangle faces and
vertices. No color information or surface normals are written. Thisis useful to export a
fractal for usein Bryce or another program that supports the Wavefront format.
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3.18.2

3.18.3

3.19

3.20

Cavests: thisis capable of generating very largefiles. The way to reducefile sizeisto
reduce cylinder or spherical forms by increasing epsilon or decreasing the circle size. Usethe
smoothing option in Bryce to round off cylinder shapes in the imported object, if possible.
(Smaller object files take less time to smooth.)

Save [POV] command

Save [POV] command (File menu)

When the active figureisacircle or cylinder plot (See FVR window), then this command is
enabled and may be selected. After naming the object file through afile requester, the current
figureis redrawn and line segments are written as spherical or cylindrical objectsin native
POV format. Each object is given different color which is selected linearly from the current
palette. A sample sceneis provided with each file written, though the absolute placement of
the Kleinian "ring" may need to be adjusted manually.

Mesh Setup command

Mesh Setup command (File menu)

Here you edit or view the parameters for simplifying meshes when outputting in Wavefront
[obj]. Max input faces and max input vertices determine how much memory is set aside as
buffers for processing the meshes. Increase or decrease from the default values as the size of
the mesh warrants, or as system memory permits. The "min radius’ variable controls how
small individual spheres or cylindrical objectsin amesh may be. Objects smaller than the
minimum radius are omitted from the exported mesh. Kleinian sets can contain alarge
amount of spheres when the sphere primitive is used and all of these increase the size of the
mesh proportionately, even the ones that may not be visible. The weld factor controls how
close adjacent triangle vertices of a mesh may be before they are merged into one vertex.
This effectively flattens adjacent triangles or "collapses’ them and reduces mesh size. Usea
small enough weld factor that produces an evenly simplified mesh without destroying the
integrity of the smallest elements of the mesh. The weld factor is not used with cylinder
plots. Use the smoothing routine in Bryce to restore the mesh to optimum curvature.

File1, 2, 3, 4,5, 6 command

1,2, 3,4,5, 6 conmand (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last six
drawings you closed. Choose the number that corresponds with the drawing you want to
open.

File Exit command

Exit command (File menu)

Use this command to end your Swirlique session. Y ou can aso use the Close command on
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the application Control menu.

Shortcuts
Mouse:  Double-click the application’'s Control menu button.

Keys. ALT+F4
4 Edit menu
Edit menu commands

The Edit menu offers the following commands:

Undo Undo last edit, action or zoom.

Copy Copy the active view and put it on the Clipboard.
Paste Insert Clipboard contents.

Copy Data Copy fractal datato buffer.

Paste Data Copy data from copy buffer.

Fractal Variables Edit fractal variables.

Size Sets the image size.

Palette Editor Edit palette.

Preferences Startup preferences and defaults.

4.1 Edit Undo command

Undo command (Edit menu)

Use this command to undo the last action. Color-cycling is disabled after using Undo,
though.

Shortcut
Keys. CTRL+Z

4.2  Edit Copy command

Copy command (Edit menu)

Use this command to copy the active view to the clipboard. The entire view is copied to the
clipboard.

Shortcut
Keys. CTRL+C
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4.3

4.4

4.5

Edit Paste command

Paste command (Edit menu)

Use this command to paste from the clipboard. The clipboard must contain a bitmap. If the
bitmap islarger than the view, it is clipped. The zoom cursor is used to set the left/top corner
in the view where the bitmap will be pasted. Click outside the view frame or press escape to
exit this option.

Shortcut
Keys. CTRL+V

Edit Copy Data command

Copy Data command (Edit menu)

Use this command to copy the fractal data for the active view to the file " (startup
dir/)zcopy.dfs'. The current palette for the view is also copied.

Shortcut
Keys. CTRL+F

Edit Paste Data command

Paste Data command (Edit menu)

Use this command to paste the datain the file " (startup dir/)zcopy.dfs' to the active view.
The palette stored in the file is copied to palette 10(F11).

Shortcut
Keys. CTRL+R
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4.6

Fractal Variables

Fractal Variables (Edit Menu)

Thisisthe main window for defining the type of Kleinian curve to be drawn and the traces
and limit variables that define the curve itself.

Function is the drop-down edit control for selecting the two-letter code for each curve
supported by Swirlique. This can be one of Grandma's curves, a Jorgensen curve, Maskit or
Riley group. Thefirst two "Grandma' curves are designed to be connected curves which
require that Zoom X be alarge value (100 is a good starting value) to display the entire curve.
(These are the main curvesillustrated in Indra's Pearls and since they are well connected you
can use thefill tool in PSP or PhotoShop to highlight in and out areas.) With values less than
10 the curves begin to be magnified and less of the curveisdisplayed. Thisacts asazoom on
the center of the curve. The Jorgensen, Maskit and Riley recipes produce infinite repeating
curves, so it is necessary to reduce Zoom X to display a good-sized image of the curves. A
value of 5-10 isagood place to start with these curves.

The higher the Max Level the more detail is displayed in a curve, but the longer it takes to
examine all of the branches that make up that curve, so plotting time is increased
proportionately. When the curves are generated randomly through the Demo menu, some
curves become chaotic with Max Level set to much above 20. Epsilon also defines resolution
in acurve, smaller making for afiner curve, and longer plotting. Practical values range from
.11t0.001. Some Grandma curves remain stable with large Max Level and smaller epsilon,
but there is no guarantee of this when the curve traces are chosen randomly.

Trace A and Trace B are complex variables that are used to enter values for traces that
duplicate curves drawn in Indra's Pearls, or you can experiment with your own values, or let
the program generate random sets of traces through the Demo menu. Be sure to experiment
with holding one or more of the trace values to a fixed value when doing a random search.
The Random/Batch window has options to do this.

Line Gap is arough gage that Swirlique uses to determine how far apart the points can be
when connecting then by lines. Any successive points that are less than Epsilon* LineGap are
connected by aline. Some curves are more digointed than others, so you don't want to
connect every successive point. If some pointsin acurve are connected at sharp angles you
may want to decrease the line gap to eliminate those lines. As Epsilon is decreased you may
have to increase LineGap to keep al the points connected.
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4.6.1

The circle and cylinder plot boxes are used with the 3-D export options, and as an aternate
way of plotting Kleinan sets. (Only filled circles are displayed in Swirlique.) Use adifferent
Ratio value from the default 1.0 to export line segments as ellipsoids and conic forms. Use
0.0 with the cylinder plot to export cones. The Size variable controls the relative size of
individual spheres or conic sections.

FVR Window

Fractal Variables Window

Thisisthe main window for defining the type of Kleinian curve to be drawn and the traces
and limit variables that define the curve itself.

Function is the drop-down edit control for selecting the two-letter code for each curve
supported by Swirlique. This can be one of Grandma's curves, a Jorgensen curve, Maskit or
Riley group. Thefirst two "Grandma' curves are designed to be connected curves which
require that Zoom X be alarge value (100 is a good starting value) to display the entire curve.
(These are the main curves illustrated in Indra's Pearls and since they are well connected you
can use thefill tool in PSP or PhotoShop to highlight in and out areas.) With values less than
10 the curves begin to be magnified and less of the curveis displayed. This acts asazoom on
the center of the curve. The Jorgensen, Maskit and Riley recipes produce infinite repeating
curves, so it is necessary to reduce Zoom X to display a good-sized image of the curves. A
value less of 5-10 isagood place to start with these curves.

The higher the Max Level the more detail is displayed in a curve, but the longer it takes to
examine al of the branches that make up that curve, so plotting timeisincreased
proportionately. When the curves are generated randomly through the Demo menu, some
curves become chaotic with Max Level set to much above 20. Epsilon also defines resolution
in acurve, smaller making for afiner curve, and longer plotting. Practical values range from
.1t0.001. Some Grandma curves remain stable with large Max Level and smaller epsilon,
but there is no guarantee of this when the curve traces are chosen randomly.

Trace A and Trace B are complex variables that are used to enter values for traces that
duplicate curves drawn in Indra's Pearls, or you can experiment with your own values, or let
the program generate random sets of traces through the Demo menu. Be sure to experiment
with holding one or more of the trace values to a fixed value when doing a random search.
The Random/Batch window has options to do this.

Line Gap is arough gage that Swirligque uses to determine how far apart the points can be
when connecting then by lines. Any successive points that are less than Epsilon* LineGap are
connected by aline. Some curves are more digointed than others, so you don't want to
connect every successive point. If some pointsin acurve are connected at sharp angles you
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may want to decrease the line gap to eliminate those lines. As Epsilon is decreased you may
have to increase LineGap to keep al the points connected.

The circle and cylinder plot boxes are used with the 3-D export options, and as an aternate
way of plotting Kleinan sets. (Only filled circles are displayed in Swirlique.) Use adifferent
Ratio value from the default 1.0 to export line segments as ellipsoids and conic forms. Use
0.0 with the cylinder plot to export cones. The Size variable controls the relative size of
individual spheres or conic sections.

4.7  Size
Size (Edit menu)

This allows you to set the drawing area for a picture, independent of the Windows screen size.
It also shows which sizeis currently in use. The custom setting allows for any size that
system memory will permit. The minimum size for an image is 40X30. Note: the image
aspect isfixed at 1/1, and images are scaled to fit the drawing window horizontally. Some
images require that the drawing window be resized vertically to contain all of the curve.

4.8 Edit Palette

Edit Palettes

Use the palette editor to modify the palette(s) in use.

It isimportant to realize that palettes are software-simulated in Swirlique (since 24-bit color
supports no hardware palettes), so color-cycling and palette switching are not fast operations
as with a 256-color system that supports pal ettes.

There are copy and spread options to smooth or customize the existing palettes in Swirlique.
Y ou can then save all the palettesin a.pl file, or by saving the entire function and bitmap
(v1.08+ saves dl the palettesin the datafile.)

With Swirlique, a palette is actually 65281 colors, with each succeeding color (except the
last) followed by 255 colors that are evenly spread from one color to the next. The color for
the limit set is defined either by index #1, when no background filter is used, or the zero
index when the background filter is non-blank.

Use the RGB-dlider controls to edit any color in the palette. Select Copy to copy any color to
another spot in the palette. Select Spread to define a smooth spread of colors from the current
spot to another spot in the palette. Copy and Spread take effect immediately when you select

© 2004-2008 ... Mystic Fractal



27

Swirlique Application Help

4.8.1

4.8.2

another spot with the mouse button. Y ou can cancel the operation with the Cancel button. In
Swirlique, colors do not cycle smoothly when you adjust the RGB/HSV dliders. Thiswould
be too slow with true color. The Apply button is used to apply color changes to an image
after you are done adjusting the sliders. In the HSV mode, color spreads are based on HSV
valuesinstead of RGB values, which in some cases results in brighter color spreads.

Right-click on any point on the main window and the palette color for that pixel will be
displayed in the palette editor. Y ou can use any of the color-cycling keys (after clicking on
the main window) to see the effects of the cycling in the palette editor window. Note: color
cycling and color-sel ection-from-pixel only works when the image has been drawn in the
current session. If you load a pre-existing image file, you must redraw it to cycle or change
colors with the Apply button, etc. Undoing an action also disables color cycling.

Use Reset to reset the colors of the palette in use, to where it was before it was cycled or
modified. Note: if you change palettes with one of the function keys, any modificationsto a
previous palette are unaffected by the Reset button.

Use Reverse to reverse the order of the colorsin the palette. This affects only those colorsin
the start-color to end-color range. Useful for reversing divide-by-eight palettes, etc., for orbit-
trap pictures that require areversed palette.

Use Neg to create a palette that is the complement of the current palette.

Use SRG to switch the red and green components of all palette colors.

Use SRB to switch the red and blue components of all palette colors. SRB and SRG are
disabled in HSV mode. Y ou can use these buttons to form eight different pal ettes by
repeatedly switching red, green and blue components.

Use Smooth to create a random palette with smooth color spreads. Use Scramble to create a
pal ette with random color indexes. The Randomize variables, rmin, rmax, bmin, bmax, gmin,
and gmax act as limits that are applied after the palette after initial randomizing, to make the
palette conform to the desired spectrum of colors.

Note: unless you click on Reset before exiting the editor, changes are permanent to the pal ette
edited, no matter which way you close the editor (Okay button or close box.)

Reverse button

Reverse button
Use Reverse to reverse the order of the colorsin the palette. This affects only those colorsin
the start-color to end-color range. Useful for reversing divide-by-eight palettes, etc., for orbit-
trap pictures that require areversed palette.

Neg Button

Neg button
Use Neg to create a palette that is the complement of the current palette.
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4.8.3

4.8.4

4.8.5

4.8.6

4.8.7

4.8.8

4.8.9

4.8.10

4.8.11

H/R Button

H/R button
Change from HSV to RGB mode or back. Inthe HSV mode, color spreads are based on HSV
values instead of RGB values, which in some cases results in brighter color spreads.

Spread Button

Spread button
Select Spread to define a smooth spread of colors from the current spot to another spot in the
palette.

Copy Button

Copy button
Select Copy to copy any color to another spot in the palette.

SRG Button

SRG button
Use SRG to switch the red and green components of all palette colors. RGB mode only.

SRB Button

SRB button
Use SRG to switch the red and blue components of all palette colors. RGB mode only.

Okay Button

Okay button
Click on Okay to exit the palette editor, applying unmapped color changes to picture (if color-
cycling is enabled.)

Reset Button

Reset button
Use Reset to reset the colors of the palette in use, to where it was before it was cycled or
modified. Note: if you change palettes with one of the function keys, any modificationsto a
previous palette are unaffected by the Reset button.

Cancel Button

Cancel button
Y ou can cancel acopy or spread operation with the Cancel button.

Apply Button

Apply button
In Swirlique, colors do not cycle smoothly when you adjust the RGB/HSV dliders. This
would be too slow with true color. The Apply button is used to apply color changes to an
image after you are done adjusting the dliders.
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4.8.12

4.8.12.1

4.8.13

4.8.13.1

4.8.14

4.8.14.1

4.8.15

4.8.16

4.9

Red Slider

Red dlider
Use the RGB/HSV-dlider controlsto edit any color in the palette.

Red edit box

Red edit box
Shows red/hue value of selected color index.

Green Slider

Green dider
Use the RGB/HSV-dlider controlsto edit any color in the palette.

Green edit box

Green edit box
Shows green/saturation value of selected color index.

Blue Slider

Blue dlider
Use the RGB/HSV-dlider controls to edit any color in the palette.

Blue edit box

Blue edit box
Shows blue/value magnitude of selected color index.

Smooth Button
Smooth button

Use to create a random palette with smooth color spreads.
Scramble Button

Scramblebutton

Use to create a pal ette with random color indexes.
Preferences

Prefer ences (Edit menu)

Image menu

I magemenu commands

The Image menu offers the following commands:
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Draw

Draw Composite

Auto Redraw
Auto Clear

Auto Sound Alert

Draw the picture.

Draw composite from figures 1-4.
Redraw image on command.

Clear drawing area before new plot.
Enable or turn off sound alerts.

Auto Remote Open remote automatically at startup.

Auto Time Show time used to plot image.

Merge Sum Merge current pixel color with previous color summing colors.
Merge And Merge current pixel color with previous color anding colors.
Merge Or Merge current pixel color with previous color oring colors.

Merge High Merge current pixel color with previous color by choosing highest
rgb.

Merge Low Merge current pixel color with previous color by choosing lowest
rgb.

Merge Back Merge current pixel color with previous color by excluding background
color.

Merge Diff Merge current pixel color with previous color by using difference of
colors.

Abort Abort drawing.

Clone Clone current view.

Full Screen View image full-screen.

Figure 1 Switch to figure one.

Figure 2 Switch to figure two.

Figure 3 Switch to figure three.

Fiqure 4 Switch to figure four.

Composite Select figures to merge.

5.1 Image Draw command

Draw command (I mage menu)

Use this command to draw or redraw the image for the current fractal variables. Clicking
inside the draw window with the left-mouse button stops all plotting.

5.2 Image Draw Composite command

Draw Composite command (I mage menu)

Use this command to draw or redraw an image defined in the Composite command as a
merging of figures 1-4. Clicking inside the draw window with the left-mouse button stops all
plotting.

5.3 Image Redraw command

Auto Redraw command (I mage menu)

With this command disabled (on by default), redraw does not occur except when the Draw
command is executed, or arandom command from the Demo menu is executed. Most of the
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5.4

5.5

5.6

5.7

5.8

time you want to see the results of changing a parameter or mapping option, so redraw occurs
automatically with parameter or mapping changes. Sometimes you want to change more than
one parameter or figure before redrawing the (composite) image. So you need to turn this
option off then.

Image Auto Clear command

Auto Clear command (I mage menu)

With this command enabled (on by default), the drawing areais cleared before starting a new
plot. You can turn off this option when you want to see the effect of minor changes to
parameters, as they affect the plot pixel by pixel, or when setting up a multiple-layered
fractal, asin acomposite image. Y ou can use the shift-c command to clear the drawing ares
at any time.

Image Auto Alert command

Auto Sound Alert command (Image menu)

With this command enabled (on by default), the user is notified by a sound clip when a
drawing is completed or user-canceled. By disabling this command the completion
exclamation is suppressed and also any alert that contains a message box. Note: some sound
clips are automatically generated by Windows, or there is no text alert for agiven error
condition. In these cases the sound alert is unaffected by the Auto Alert command.

Image Auto Remote command

Auto Remote command (I mage menu)

With this command enabled (on by default), the remote is opened immediately at program
startup. Handy if you find the remote useful and don't want to click on the toolbar button
each time the program starts up.

Image Auto Time command

Auto Timecommand (I mage menu)

With this command enabled (on by default), the time that an image takes to plot is displayed
when the plot is complete. Swirlique saves the condition of this option at session's end, so if
you disable it and close the program, the option will be disabled when you restart Swirlique.

Image Merge Sum command

M er ge Sum command (I mage menu)

With this command enabled (off by default), current pixel color is not overwritten when a
new image isdrawn. Instead the colors are merged using a summing algorithm. The auto-
clear option must be disabled and solid-guessing off to choose this option. Useful to merge
two or more separate fractal images/types with the initial image(s) "bleeding" through.
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5.9

5.10

5.11

5.12

5.13

Image Merge And command

Merge And command (I mage menu)

With this command enabled (off by default), current pixel color is not overwritten when a
new image isdrawn. Instead the colors are merged using an anding algorithm. The auto-
clear option must be disabled and solid-guessing off to choose this option. Useful to merge
two or more separate fractal images/types with the initial image(s) "bleeding” through.

Image Merge Or command

Merge Or command (I mage menu)

With this command enabled (off by default), current pixel color is not overwritten when a
new image is drawn. Instead the colors are merged using an oring algorithm. The auto-clear
option must be disabled and solid-guessing off to choose this option. Useful to merge two or
more separate fractal images/types with the initial image(s) "bleeding” through.

Image Merge High command

Merge High command (Image menu)

With this command enabled (off by default), current pixel color is not overwritten when a
new image isdrawn. Instead the colors are merged using the highest rgb values of both
images. The auto-clear option must be disabled and solid-guessing off to choose this option.
Useful to merge two or more separate fractal images/types with the initial image(s) "bleeding”
through.

Image Merge Low command

Mer ge L ow command (I mage menu)

With this command enabled (off by default), current pixel color is not overwritten when a
new image is drawn. Instead the colors are merged using the lowest rgb values of both
images. The auto-clear option must be disabled and solid-guessing off to choose this option.
Useful to merge two or more separate fractal images/types with the initial image(s) "bleeding”
through.

Image Merge Back command

Merge Back command (I mage menu)

With this command enabled (off by default), current pixel color is not overwritten when a
new image is drawn. Instead the colors are merged using the rgb components of the new
image if the new color index is not zero; else the old rgb values are retained. The auto-clear
option must be disabled and solid-guessing off to choose this option. Useful to merge two or
more separate fractal images/types with the initial image(s) "bleeding” through.

© 2004-2008 ... Mystic Fractal



33

Swirlique Application Help

5.14

5.15

5.16

5.17

5.18

5.19

Image Merge Diff command

Mer ge Diff command (I mage menu)

With this command enabled (off by default), current pixel color is not overwritten when a
new image is drawn. Instead the colors are merged using the difference of the rgb values of
both images. The auto-clear option must be disabled and solid-guessing off to choose this
option. Useful to merge two or more separate fractal images/types with the initial image(s)
"bleeding” through.

Image Abort command

Abort command (I mage menu)

Use this command to stop drawing. Clicking inside awindow's drawing area or close box (or
the program close box) will also stop the drawing. Note: once a plot has started Swirlique
continues to draw the image for that window regardless of which drawing window has the
input focus, until done or aborted. Y ou can open and close other drawing windows without
affecting the current drawing, but only one drawing is active at any time.

Image Clone

Clone (Image menu)

A new draw window is opened that contains the same fractal data as the window it was
opened from. Thisisuseful for comparing minor changes in texturing options, etc. Similar
to using the copy/paste data commands except that all figures are copied to the new view.

Full Screen

Full Screen (Image menu)
Displays the entire plot, expanding or shrinking the image to fit in a maximized window
without title bar, scroll bars or menu bar. At al other times, part of the picture is hidden by
the inclusion of the title bar, toolbar, scroll bars and menu bar. To exit full-screen mode,
press any key or click the left-mouse button.

Figure #1

Figure#1
Switch to Function #1. Current settings are saved under the previous image.

Figure #2

Figure#2
Switch to Function #2. Current settings are saved under the previous image.
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5.20 Figure #3

Figure#3
Switch to Function #3. Current settings are saved under the previous image.

5.21 Figure #4

Figure#4
Switch to Function #4. Current settings are saved under the previous image.

5.22 Image Composite command

Compositecommand (I mage menu)

Opens the Composite Figure window, where you can define a set of figures to merge into one
image. All the merging optionsin the Merge Color menu are supported, plus"ALL" whichis
usually used for the first figureto be drawn. The"ALL" option transfers all rgb information
for afigure to the drawing area, without checking the rgb state of the pixel. You can define
up to four figures (layers), as part of the composite, but each figure should contain an image
(if used in the composite.)

6 Color menu

Color menu commands

The Color menu offers the following commands:

Cycle Cyclecolors.

Pal ette menu Select from palettes 1-21.
Backaround Filter Define coloring filter for background.
Flood Fill Fill areawith color index #255

6.1 Color Cycle command

Cyclecommand (Color menu)

Use this command to cycle colors when not plotting. Undoing an action disables the cycle
command until the image is redrawn.

6.2 Palette menu

Palette menu commands
The Palette menu (in Color menu) offers the following commands:

Palette #1-21 Use one of 21 palettes.
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6.2.

6.3

1

Palette 1-21 command

Palette command (Palette menu)

Switch to palette #. Used with palette-col oring mode.
Background Filter...

Background Filter

Here you define a background filter based on a complex function. The function is used to fill
the background with a texture instead of a solid background. The function can be any
formula, up to 80 characters, that usesthe variables x, y and z. X and y are the horizontal and
vertical components of each pixel. Z isthe complex form x+yi. The Magnify dider is used to
control the intensity of thefilter. Use the Preview button to see what the filter looks like with
x and y ranges of -2pi to 2pi. When the coloring filter formulais defined, up to 235 colors can
be used (the full palette) to create mixed textures.

Par ser Information

Functions (capital letters are optional, and parenthesis are necessary around complex
expressions)

The following information takes the form "standard function” ---"form used by Swirlique to
represent standard function”.

sinez---sin(z) or SIN(Z) ; where Z can be any complex expression
hyperbolic sine z --- sinh(z) or SINH(Z)

arcsine z --- asin(z) or ASIN(Z)

cosine z --- cos(z) or COS(Z)

hyperbolic cosine z --- cosh(z) or COSH(Z2)
arccosine z --- acos(z) or ACOS(2)

tangent z --- tan(z) or TAN(Z)

hyperbolic tangent z --- tanh(z) or TANH(Z2)
arctangent z --- atan(z_) or ATAN(Z)

cotangent z --- cotan(z) or COTAN(Z)

arccotangent z --- acotan(z) or ACOTAN(Z)

e’z --- exp(z) or EXP(z) -- the exponential function
natural log of z --- log(z) or LOG(Z)

absolute value of z --- abs(z) or ABS(Z2)
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sguare root of z --- sgrt(z) or SQRT(Z)

z squared --- sgr(z) or SQR(2)

real part of z --- real(z) or REAL(Z)

imaginary part of z --- imag(z) or IMAG(Z)

modulus of z --- mod(z) or MOD(Z) or |z| -- (X*X +y*Y)
conjugate of z -- conj(z) or CONJ(2) -- (x-yi)

polar angle of z -- theta(z)

Math operators

+ --- addition

- --- subtraction

* -—- multiplication
[ --- division

A --- power function
Constants

e ---eor E -- 1eMl -- 2.71828, read/write.
i -—-iorl --sguareroot of -1,read/write.

6.4 Flood Fill
Flood Fill

Here you have the option of filling either the inside or outside of the limit set, or
portions thereof. When this command is selected the cursor changes to a small black
& white arrow and you position the white spot over the area you want to fill. Click on
the left mouse button to fill the area with color index #255 (the last palette color.)
Press <Esc> or click outside the current drawing area to exit this mode. The flood fill
command uses a border fill algorithm, limiting itself to color index #1 or the zero index
(if the background filter is non-blank) so it also works when a background filter is
used.

Hint: you can change color index #255 to fill other areas of the same image with a
different color.

Notes: There seems to be a limit on how large a bitmap the flood fill command works
on, so the program limits this option to bitmaps 8000X7200 or smaller. On the more
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7.1

7.1.1

intricate limit sets it is necessary to use fairly large bitmaps to ensure that the smallest
details get filled. Even then, you may need to adjust Epsilon upward if the gaps in the
set are too close to fill through. This command should be used last after all other
details of an image are worked out, as each time you redraw the image the
filled areas are erased. If you change the palette after a fill operation you need
to redraw the image to use the new palette with the fill command.

View menu

View menu commands
The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar  Shows or hides the status bar.

View Toolbar command

Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the
most common commands in Swirlique, such as File Open. A check mark appears next to the
menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.
toolbar

Toolbar

SEE]

The toolbar is displayed across the top of the application window, below the menu bar. The
toolbar provides quick mouse access to many tools used in Swirlique,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To
3:€ Open the remote which contains shortcut buttons for many common tasks and
options in Swirlique

= Open an existing drawing. Swirlique displays the Open dialog box, in which you
can locate and open the desired file.

= Save the active drawing or template with anew name. Swirlique displays the Save
Asdiaog box.

Xy Set image size.
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Edit palette.

Edit fractal parameters.

Draw image from current parameters.
Show picture full-screen.

Display info about Swirlique.
Display Swirlique's help index.

P@ED@&

7.2 View Status Bar Command

Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be
executed by the selected menu item or depressed toolbar button, and keyboard latch state. A
check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.
7.2.1 status bar

Status Bar

cap

The status bar is displayed at the bottom of the Swirlique window. To display or hide the
status bar, use the Status Bar command in the View menu.

The |eft area of the status bar describes actions of menu items as you use the arrow keys to
navigate through menus. This area similarly shows messages that describe the actions of
toolbar buttons as you depress them, before releasing them. If after viewing the description of
the toolbar button command you wish not to execute the command, then release the mouse
button while the pointer is off the toolbar button.

Theright areas of the status bar indicate which of the following keys are latched down:

Indicator Description

CAP The Caps Lock key is latched down.
NUM The Num Lock key islatched down.
SCRL The Scroll Lock key is latched down.

8 Window menu

Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple
images in the application window:

Cascade Arranges windows in an overlapped fashion.
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8.2

8.3

8.4

8.5

Tile Arranges windows in non-overlapped tiles.
Arrange Icons Arrangesicons of closed windows.

Size Desktop Size drawing area to window frame.
Window 1, 2, ... Goes to specified window.

Cascade

Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion.

Tile
Tilecommand (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.

Arrange lcons

Window Arrange | cons Command

Use this command to arrange the icons for minimized windows at the bottom of the main
window. If thereisan open drawing window at the bottom of the main window, then some or
all of the icons may not be visible because they will be underneath this drawing window.

Size DeskTop

Window Size DeskTop Command

Use this command to size the active drawing window to its frame size. Use after Tile
command to reduce white space around a drawing that is smaller than screen size.

1,2, ..
1, 2, ... command (Window menu)
Swirlique displays alist of currently open drawing windows at the bottom of the Window

menu. A check mark appearsin front of the drawing name of the active window. Choose a
drawing from thislist to make its window active.

A/V menu

A/V menu commands
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The A/V menu offers the following commands:

Open AVI Stream  Open AVI file for writing and draw initial frame.

Write Frames Write framesto AV file.
Close AVI Stream  Close an existing AV stream.
View AVI View an AVI animation file.
AVI Composite Generate composite video.

9.1 Open Avi Stream

Open Avi Stream...
Through a series of windows, this allows you to name and open an avi animation stream and
choose a compression method. After using the file requester to name the file, you are given a
choice of compression methods. The compression methods include Intel Indeo Video®,
Microsoft Video 1 and Cinepak Codec by Radius. (All compression methods degrade the
original images, some more than others.) The first key frame in the stream is then drawn and
written to the file.

Notes: after the stream is opened, the size of the fractal that can be drawn isfixed at the size
of the frame. No changes can be made to the size until the stream is closed. New: If you
open avideo stream after setting up a batch mode (Demo menu), then the frames will be
written as a series of bmp, obj or wrl files, depending on whether AVI Object or AVI WRL is
also checked.

9.2 Write Frames

Write Frames...
With this option, frames are written to a stream based on the difference between the current
key frame and the previous key frame. The first key frame is written when you open a
stream. The next key frame s created each time you use this option. In between you can
zoom or change Avi variables as much as necessary. The stream is only written to when this
optionisused. Thelast key frame is automatically saved after the ‘tween' seriesiswritten.
The number of frames may range from 1-1500 frames between keys. With aframe number of
1 only the key frames are written. This allows animation to be created that incorporates all
scalable variables in Swirlique.

Use the Cancel button to exit this dialog without initializing a new series of frames.

Check the Log Scaling box if you want the frames to be written with logarithmic space
between frames, else linear space is used. Useful when zooming, where frames would
otherwise be packed together at the end of the frame series.

Notes: key frames are saved in parameter files (.dfs), with filenames of
"bvf_imaget# title.dfs’, where '# isthe number of the keyframe and 'title' is the name of the
working fractal file.
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9.3

9.4

9.5

10

Close Avi Stream

Close Avi Stream
Closes any open avi stream file. Y ou need to do this before viewing the file or creating a new
avi file. The stream is also closed when you exit Swirlique.

View Avi

View Avi...
Opens an avi file for viewing. You can preview any multimediafile by clicking onitsfile
name. A multimedia box will appear to the right of the filelist. Click on okay to open the
main view window.

There are buttons to Play afile forwards or Backwards, or forward automatically with Auto
rewind/repeat. Click on Slow to slow down avideo. Each click on Slow halves the viewing
speed. A click on Stop freezes viewing and restores the view speed to normal playback.

Use the Open button to view a different avi file. Use the Save button to save thefilein a
different compression format. Y ou must use a different name to save the file than the name
that was used to open it. Click on the left-mouse button or any key to abort a save operation.

Note: the view avi requester can be used to preview any multimediafile, including midi files.
Avi Composite

AVI Composite
When thisflag is set, Swirlique generates composite frames for a video according to the
settings in the Image/Composite window. Each frame may then consist of a merging of up to
4 figures (1-4). You must set this flag and the composite options before beginning a video.
After an avi stream has been opened, you can then use variations of any figure in the
composite to produce tweens while using the Write Frames option. Asusual, you vary datain
the figure(s) before writing frames.

Demo menu

Demo menu commands

The Demo menu offers the following commands, which illustrate various features of
Swirlique:

Random Grandma #1 Generate random Grandma's parabolic commutator groups

Random Grandma #2 Generate random Grandma's four-alarm two-generator groups
Random Grandma #3 Generate random Grandma's parabolic commutator (variation of G1)
Random Grandma #4 Generate random Grandma's parabolic commutator (variation of G1)
Random Jorgensen #1Generate random Jorgensen parabolic groups #1

Random Jorgensen #2Generate random Jorgensen parabolic groups #2

Random Jorgensen #3Generate random Jorgensen parabolic groups (variation of J2)
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Random Jorgensen #4Generate random Jorgensen parabolic groups (variation of J1)
Random Maskit Generate random Maskit parabolic groups

Random Riley Generate random Riley parabolic groups
Batch Mode Repeat random fractal and save to file.

10.1 Random Grandma #1

Random Grandma #1

This command generates a random Kleinian curve based on Grandma's parabolic commutator
groups recipe. Parameters are randomized according to the settings in the Random/Batch window.
The random search looks for the first non-chaotic grouping and plots it. Any curve that appears
chaotic in the first 1000 points is skipped.

10.2 Random Grandma #2

Random Grandma #2

This command generates a random Kleinian curve based on Grandma's four-alarm two-generator
groups recipe. Parameters are randomized according to the settings in the Random/Batch window.
The random search looks for the first non-chaotic grouping and plots it. Any curve that appears
chaotic in the first 1000 points is skipped.

10.3 Random Grandma #3

Random Grandma #3

This command generates a random Kleinian curve based on a variation of Grandma's parabolic
commutator groups recipe. Parameters are randomized according to the settings in the
Random/Batch window. The random search looks for the first non-chaotic grouping and plots it. Any
curve that appears chaotic in the first 1000 points is skipped.

10.4 Random Grandma #4

Random Grandma #4

This command generates a random Kleinian curve based on a variation of Grandma's parabolic
commutator groups recipe. Parameters are randomized according to the settings in the
Random/Batch window. The random search looks for the first non-chaotic grouping and plots it. Any
curve that appears chaotic in the first 1000 points is skipped.

10.5 Random Jorgensen #1
Random Jorgensen #1

This command generates a random Kleinian curve based on Danish mathematician Tropels
Jorgensen's recipe. Parameters are randomized according to the settings in the Random/Batch
window. As this is an infinitely repeating horizontal curve, adjust ZoomX to a small value, less than
10, to see more of the curve. The random search looks for the first non-chaotic grouping and plots it.
Any curve that appears chaotic in the first 1000 points is skipped.
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10.6

10.7

10.8

10.9

10.10

Random Jorgensen #2
Random Jorgensen #2

This command generates a random Kleinian curve based on the alternate form of Danish
mathematician Tropels Jorgensen's recipe. Parameters are randomized according to the settings in
the Random/Batch window. As this is an infinitely repeating horizontal curve, adjust ZoomX to a small
value, less than 10, to see more of the curve. The random search looks for the first non-chaotic
grouping and plots it. Any curve that appears chaotic in the first 1000 points is skipped.

Random Jorgensen #3
Random Jorgensen #3

This command generates a random Kleinian curve based on a variation of Danish mathematician
Tropels Jorgensen's alternate recipe. Parameters are randomized according to the settings in the
Random/Batch window. As this is an infinitely repeating horizontal curve, adjust ZoomX to a small
value, less than 10, to see more of the curve. The random search looks for the first non-chaotic
grouping and plots it. Any curve that appears chaotic in the first 1000 points is skipped.

Random Jorgensen #4
Random Jorgensen #4

This command generates a random Kleinian curve based on a variation of Danish mathematician
Tropels Jorgensen's recipe. Parameters are randomized according to the settings in the
Random/Batch window. As this is an infinitely repeating horizontal curve, adjust ZoomX to a small
value, less than 10, to see more of the curve. The random search looks for the first non-chaotic
grouping and plots it. Any curve that appears chaotic in the first 1000 points is skipped.

Random Maskit
Random Maskit

This command generates a random Kleinian curve based on Bernard Maskit's recipe. Parameters
are randomized according to the settings in the Random/Batch window. As this is an infinitely
repeating horizontal curve, adjust ZoomX to a small value, less than 10, to see more of the curve. The
random search looks for the first non-chaotic grouping and plots it. Any curve that appears chaotic in
the first 2000 points is skipped.

Random Riley
Random Riley

This command generates a random Kleinian curve based on Robert Riley's recipe. Parameters are
randomized according to the settings in the Random/Batch window. As this is an infinitely repeating
horizontal curve, adjust ZoomX to a small value, less than 10, to see more of the curve. The random
search looks for the first non-chaotic grouping and plots it. Any curve that appears chaotic in the first
1000 points is skipped.
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10.11 Random/Batch options

Random/Batch window (Demo menu)

Here you set parameters for batching and saving random-generated images to disk. When the
Repetitions value is non-zero, up to 1000 random images can be generated and saved to disk.
Use a unique Filename to prevent batch files from overwriting existing image files.

There are radio boxes that allow you to customize how random variables are processed to
create new Kleinian fractals:

Trace A.re -- (default on) check to randomize the real part of Trace A

Trace A.im -- (default on) check to randomize the imaginary part of Trace A
Trace B.re -- (default on) check to randomize the real part of Trace B

Trace B.im -- (default on) check to randomize the imaginary part of Trace B
Max Level -- (default on) check to set Max Level to adefault value

Epsilon -- (default on) check to set Epsilon to a default value

Zoom X -- (default on) check to set Zoom X to adefault value

Any box that is unchecked means that value is unchanged during the random search for new
fractals.

11  Help menu
Help menu commands

The Help menu offers the following commands, which provide you assistance with this

application:

Getting Started Tutorial for new users of Swirlique.

Index Offers you an index to topics on which you can get help.
Bibliography Sources for fractal information and complex numbers.

About Swirligue Displays the version number and author info for this application.
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11.1

Getting Started
Getting Started

Welcome to Swirlique!

Thisisashort tutorial that will cover basic commands and background material necessary for
anew user to create an initia picture with Swirligue. For help on any menu command, press
F1 while the command is highlighted. For help on the Edit Fractal Variables window, click
on the Help button inside that window.

To generate a Kleinian curve manually open the Fractal Variables window viathe FVR
button and enter the trace values as desired, plus any other adjustments to the fractal
variables. Click on Apply to start the plotting process. The curve is computed once for
scaling purposes, then a second time to actually plot the curve. If you have entered trace
variables that result in a chaotic curve, which results in an abnormally long calculation time,
you may have to stop the calculating process by clicking in the draw window. Y ou may also
want to stop the calculating process to enter asmaller Max Level value or larger Epsilon to
speed up the preliminary drawing. Generally alarger Max Level value and smaller Epsilon
value result in amore detailed curve, but increase plotting/cal culation time proportionately.
Some curves become chaotic with Max Level values much above 20.

To generate aKleinian curve randomly, click on one of the random buttons on the Remote.
The program will adjust trace variables automatically or as the setup in the Random/Batch
window alows. For some random searches you may want to set a trace to a standard value
like 2+.05i and randomize the other. The program will hunt for a non-chaotic curve that
follows afairly sequential path. If the curve meanders excessively (non-sequential) in the
first 1000 points the curve is considered chaotic and the program will pick another set of
variablesto plot. No plotting occurs until the extent of the curve is known, and then the
points are scaled to fit horizontally in the draw window. Some curves may require that the
verical height of the draw window be increased to contain the entire curve. You can also
reduce the Zoom X variable to plot only ahorizontal dlice of the curve. This can have the
effect of lengthening the curve in the vertical direction which would also require an
adjustment to the vertical height of the draw window.

Note: Asyou explore the many optionsincluded in Swirlique you'll find that a couple of the
windows are non-modal, so they can stay open while the fractal is being plotted. This allows
you to change some coloring or mapping variables without redrawing the fractal, or
repeatedly experiment with other aspects of the fractal-design process. The non-modal
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windows have an Apply button for applying changes directly without closing the window, or
an Okay button for applying changes and closing the window. To close the window without
making any further changes, click on the window's close button. The Cancel button, if
present, allows you to revert to when the window was last opened. Some commands external
to the window may cause it to close and reopen if variables were changed externally. In this
case Cancel "goes back" to after the window was reopened.

Swirlique allows you to Undo the last command in most cases. However thisis mostly a
failsafe command, as it disables color-cycling and requires you to redraw the fractal to change
colors.

This completes the Getting Started tutorial. The Bibliography lists additional reference
material for a better understanding of the fractal types and functions contained in Swirlique.

11.2 Index

Index command (Help menu)

Use this command to display the opening screen of Help. From the opening screen, you can
jump to step-by-step instructions for using Swirlique and various types of reference
information.

Once you open Help, you can click the Contents button whenever you want to return to the
opening screen.
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Swirligue plots Kleinian limit sets based on the "depth-first search™ algorithm and the two-
generator "'recipes’ in the book Indras Pearls, (c) 2002 Cambridge University Press, by David
Mumford, Caroline Series and David Wright.

Swirlique requires atrue-color video adapter for best results.

Acknowledgements: Many special thanks to Jos Leys for steering me through the cliffsand
canyons of Indra's pseudo-code and helping me along when | got stuck trandating the
essential detailsinto "C++" ... Also | would like to thank Bob Margolis for first drawing my

attention to the wonderful world of Indra's Pearl's and Jos Ley's extraordinary Kleinian
galeries.

Wavefront is atrademark of Alias)\Wavefront, adivision of Silicon Graphics Limited.

For ashort history of my other programs, see Chronology.

11.4.1 Chronology

Chronology
History of the programs:
In September 1989, | first had the idea for afractal program that allowed plotting all complex
functions and formulas while attending a course on College Algebra at Lane College in
Eugene, Oregon. In November 1989, ZPlot 1.0 was done. This Amiga program supported up
to 32 colors, 640X400 resolution, and included about 30 built-in formulas and asimple
formula parser.
May 1990 -- ZPlot 1.3d -- added 3D projections for all formulasin the form of height fields.
May 1991 -- ZPlot 2.0 -- first 236-color version of ZPlot for Windows 3.0.

May 1995 -- ZPlot 3.1 -- ZPlot for Windows 3.1 -- 60 built-in formulas. Added hypercomplex
support for most built-in formulas.

May 1997 -- ZPlot 24.02 -- first true color version of ZPlot -- 91 built-in formulas. Included
support for 3D quaternion plots, Fractint par/frm files, Steve Ferguson'sfilters, anti-aliasing
and Paul Carlson's orbit-trap routines.

June 1997 -- ZPlot 24.03 -- added Earl Hinrichs Torus method.

July 1997 -- ZPlot 24.08 -- added HSV filtering.

December 1997 -- Fractal Elite 1.14 -- 100 built-in formulas; added avi and midi support.

March 1998 --Split Fractal Elite into two programs, Dreamer and Medusa(multimedia.)
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April 1998 -- Dofo 1.0 -- supports new Ferguson/Gintz plug-in spec.

June 1998 -- Dofo-Zon -- redesigned multi-window interface by Steve Ferguson, and includes
Steve's 2D coloring methods.

August 1998 --Dofo-Zon Elite -- combination of Fractal Elite and Dofo-Zon

October 1998 -- Dofo-Zon Elite v1.07 -- added orbital fractals and | FS slide show.
November 1998 -- Dofo-Zon Elite v1.08 -- added |systems.

April 1999 -- Split Dofo-Zon Elite into two programs: Fractal Zplot using built-in formulas
and rendering methods, and Dofo-Zon to support only plug-in formulas and rendering

methods.

May 1999 -- Fractal Zplot 1.18 -- added Phong highlights, color-formula mapping and
random fractal methods.

June 1999 -- completed Fractal ViZion -- first version with automatic selection of
variables/options for all fractal types.

July 1999 -- Fractal Zplot 1.19 -- added cubic Mandel brot support to quaternion option; first
pc fractal program to render true 3D Mandelbrots.

September 2000 -- Fractal Zplot 1.22 -- added support for full-screen AVI video, and
extended quaternion design options.

October 2000 -- QuaSZ (Quaternion System Z) 1.00 -- stand alone
guaternion/hypernion/cubic Mandelbrot generator

November 2000 -- Added octonion fractals to QuaSZ 1.01.
March 2001 -- Cubics 1.0 -- my first totally-3D fractal generator.

May 2001 -- QuaSZ 1.03 -- added Perlin noise and improved texture mapping so texture
tracks with animations.

June 2001 -- Fractal Zplot 1.23 -- added Perlin noise and quat-trap method.

July 2001 -- QuaSZ 1.05 -- improved performance by converting many often-used dialogsto
non-modal type.

October 2001 -- FraSZle 1.0, QuaSZ formula and algebra compatible version of Fractal Zplot
November 2001 -- DynaMaSZ 1.0, the world's first Dynamic Matrix Systems fractal generator

January 2002 -- MiSZle 1.1 -- generalized fractal generator with matrix algebra extensions
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May 2002 -- DynaMaSZ SE 1.04 (unreleased version)-- scientific edition of DMZ, includes
support for user-variable matrix dimensions (3X3 to 12X12)

January 2003 -- Pod ME 1.0 -- first stand-alone 3-D loxodromic generator, Hydra 1.0 -- first
3-D generator with user-defined quad types and Fractal Projector a Fractal ViZion-like
version of DMZ SE limited to 3X3 matrices

May 2003 -- QuaSZ 3.052 -- added genetic-style function type and increased built-in formulas
to 180. Other additions since July 2001: generalized coloring, support for external coloring
and formula libraries, and Thomas Kroner's loxodromic functions.

May 2003 -- FraSZle and Fractal Zplot 3.052 -- added random 3D orbital fractals, new 3D
export methods, upgraded most frequently-used dialogs to non-modal type and added genetic-
style function type. FZ now based on FraSZle except for built-in formulalist and Newton
support.
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Swirlique Application Help
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